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COMPUTER NOTES FORM 2 
 

(amosobiero7@gmail.com) 
 

By Sir Obiero Amos Resources 

 
 

CHAPTER 1 

 

WORD PROCESSORS 

 
This chapter introduces the student to what Word Processors are, and how they are 

used. 

 
 

1.1 Definition of a Word Processor 

1.2 Purpose of Word Processing 
1.3     Using a Word Processor 

     1.4     Format and edit a document 

1.5 Create and edit a table 
     1.6     Create and edit a mail merge document 

1.7 Print a document 

     1.8     Insert and edit objects 
 

 

 

1.1 DEFINITION OF A WORD PROCESSOR 

 

A Word Processor (WP) is an application or a program (software) that converts 
letters into words, words into sentences, sentences into paragraph and paragraph into 
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a document for purposes of communication. This process is known as Word 

Processing. 

There are several word processors available for users in the work place and in 

schools. Examples include: Ms-Word, Word Perfect, WonderWord, WordPro and so 

on. 
 

1.2 Features of Word Processors 

 

All word processors possess certain features that are unique to them. The following 

are some of the features of WP. 

1. Cursor – all WP possess a blinking cursor that shows the user where next to 
type. You can only be able to type exactly at the position of the cursor. Once 

you type, the cursor then moves to the next available space. 

2. Formatting and Editing –Formatting is changing the appearance of text by 
selecting font(typeface or hand writing style), colour, alignment, indentation 

(moving text away from the margins), bolding, changing size, underline, italic 

and making bulleted list. Editing is correcting errors and ensuring clarity and 
accuracy like removing spelling and grammar mistakes. 

3. Spelling and grammar check- WPs have the ability to check the spelling and 

the grammar of a document. This can be set to indicate such mistakes by 
showing different colours on them. For example in Ms-Word, spelling mistakes 

are underlined in red and grammar are underlined in green. The user then has 

the chance to correct the mistakes either immediately or after completing the 
task being done. Refer to section 1.5 for details. 

4. Word Wrap- WPs have the ability to take an incomplete word to the next line 

automatically without pressing the enter key. This is known as word wrap. 
 

5. Thesauras- this is a Greek word for storehouse. It stores synonyms and 

antonyms of different words. The user of the WP has the option to obtain 
different words which mean the same or opposite as the word to be changed.  

6. Auto-correct- word which is frequently used with WP can be made to 

automatically be corrected or be completed by WP in the process of typing, 
hence the name auto-correct. Refer to section 1.4 for details. 

7. Undo and redo- any action done by the user of the WP, can be undone by these 

two features. If the user types some words which was not intended, one has the 
option to click undo button for the action to be omitted or if one had deleted 
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some word or sentence or paragraph by mistake, one simply presses the redo 

button to have the same deleted items back to the right place. 
8.  Mail Merge- this is the ability of WP to create a common letter, e-mail or 

labels and add different addresses or particulars to each letter for different 

people at the same time. It has three main parts: creating main letter, creating 
addresses and merging the addresses to the letter. Refer to section 1.7 for 

details. 

9. Dictionary – WP has a dictionary where certain words can be added, to make 
them accepted by WP such that it will not show the red colour symbolizing that 

it is a spelling mistake or a non English word. You can add nouns from a 

different language and WP will recognize them as part of the English language. 
Depending on the default language used by the computer, certain words may 

not be accepted though they are English words. You need to add such words to 

the dictionary of WP. For example, British English will accept labour, but 
American will only accept labor and so on. 

 

 

 

1.3 Purpose of a Word Processor  

The purpose of a WP from the definition above is to create documents for purposes 
of communication. The essence of any word processing is to enable messages to be 

created for onward transmission to the reader. Such documents in the work place 

include letters, reports, circulars, emails, newsletters, memos and so on. The 
documents can then be printed, or conveyed through other means such as e-mails, or 

through facsimile (fax). 

 
1.4 Using a Word Processing Package 

 

 

1.4.1 Getting started 

The first thing is to load the WP application you intend to use. The example 

that follows will make use Microsoft Word (MS-Word) as a platform since 
most schools and organisations use the same. The operating system under 

which the MS-Word is running is known as Windows Xp. 

 

• To load the application to the following: 
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• Click Start button 

• Go to All programs 

• Click Microsoft office 

• Click Microsoft office Word 

 

 

 
 
The Microsoft Word window appears and your screen looks similar to the one shown 

here.  
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Note: 

Your screen will probably not look exactly like the screen shown. In Word 2007, 

how a window displays depends on the size of your window, the size of your monitor, 
and the resolution to which your monitor is set. Resolution determines how much 

information your computer monitor can display. If you use a low resolution, less 

information fits on your screen, but the size of your text and images are larger. If you 
use a high resolution, more information fits on your screen, but the size of the text 

and images are smaller. Also, Word 2007, Windows Vista, and Windows XP have 

settings that allow you to change the color and style of your windows. 
 

THE MICROSOFT OFFICE BUTTON 

In the upper-left corner of the Word 2007 window is the Microsoft Office button. 
When you click the button, a menu appears. You can use the menu to create a new 

file, open an existing file, save a file, and perform many other tasks. 
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THE QUICK ACCESS TOOLBAR 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access 

toolbar provides you with access to commands you frequently use. By default Save, 

Undo, and Redo appear on the Quick Access toolbar. You can use Save to save your 
file, Undo to rollback an action you have taken, and Redo to reapply an action you 

have rolled back. 

 

 
 

THE TITLE BAR 

Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of 

the document on which you are currently working. Word names the first new 

document you open Document1. As you open additional new documents, Word 
names them sequentially. When you save your document, you assign the document 

a new name. 

 
 

 

 

 
 

THE RIBBON 

You use commands to tell Microsoft Word what to do. In Microsoft Word 2007, you 

use the Ribbon to issue commands. The Ribbon is located near the top of the screen, 

below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking 
a tab displays several related command groups. Within each group are related 

command buttons. You click buttons to issue commands or to access menus and 

dialog boxes. You may also find a dialog box launcher in the bottom-right corner of 
a group. Clicking the dialog box launcher gives you access to additional commands 

via a dialog box. 
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THE RULER  

The ruler is found below the Ribbon. 

 

 
 

You can use the ruler to change the format of your document quickly. If your ruler 

is not visible, follow the steps listed here: 
 

 
 
1. Click the View tab to choose it. 

2. Click the check box next to Ruler in the Show/Hide group. The ruler appears 

below the Ribbon.  
 

THE TEXT AREA  

Just below the ruler is a large area called the text area. You type your document in 
the text area. The blinking vertical line in the upper-left corner of the text area is the 

cursor. It marks the insertion point. As you type, your text displays at the cursor 

location. The horizontal line next to the cursor marks the end of the document. 
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THE VERTICAL AND HORIZONTAL AND VERTICAL SCROLL BARS  

The vertical and horizontal scroll bars enable you to move up, down, and across your 

window simply by dragging the icon located on the scroll bar. The vertical scroll bar 
is located along the right side of the screen. The horizontal scroll bar is located just 

above the status bar. To move up and down your document, click and drag the 

vertical scroll bar up and down. To move back and forth across your document, click 
and drag the horizontal scroll bar back and forth. You won't see a horizontal scroll 

bar if the width of your document fits on your screen. 

 

THE STATUS BAR  

The Status bar appears at the very bottom of your window and provides such 

information as the current page and the number of words in your document. You can 
change what displays on the Status bar by right-clicking on the Status bar and 

selecting the options you want from the Customize Status Bar menu. You click a 

menu item to select it. You click it again to deselect it. A check mark next to an item 
means it is selected. 



amosobiero7@gmail.com 

 

 

Page | 10  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

 
 

Understanding Document Views  

In Word 2007, you can display your document in one of five views: Draft, Web 

Layout, Print Layout, Full Screen Reading, or Online Layout.  

 
Draft View 

Draft view is the most frequently used view. You use Draft view to quickly edit your 

document. 
 

 

 

 

Web Layout 

Web Layout view enables you to see your document as it would appear in a browser 
such as Internet Explorer. 

 

Print Layout 

The Print Layout view shows the document as it will look when it is printed. 
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Reading Layout 

Reading Layout view formats your screen to make reading your document more 
comfortable. 

 

Outline View 

Outline view displays the document in outline form. You can display headings 

without the text. If you move a heading, the accompanying text moves with it. You 

should use Draft view for these lessons. Before moving ahead, make sure you are in 
Draft view:  

 

 

1. Click the View tab. 
2. Click Draft in the Document Views group. When the Draft option is selected it 

appears in a contrasting color. 
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CLICK 

During the lessons that follow, you will be asked to "click" items and to choose tabs. 
When asked to click: 

 

1. Point to the item.  
2. Press your left mouse button once.  

 

If you are asked to double-click an item:  
 

1. Point to the item.  

2. Quickly press your left mouse button twice. 
 

If you are asked to right-click: 

 
1. Point to the item. 

2. Press your right mouse button. 

 
If you are asked to choose a tab, click the tab.  

 

UNDERSTANDING NONPRINTING CHARACTERS  

Certain characters, called nonprinting characters, do not print and will not appear in 

your printed document but do affect your document layout. You can elect to see these 

characters on the screen as you type or you can elect to have them remain invisible. 
For these lessons, opt to see them onscreen. This table describes most of them: 

 

C h a r a c t e r D e n o t e s 

 A  t a b   

   . A  s p a c e 

 

 

 ¶ The end of a paragraph 

 H i d d e n  t e x t 
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To view nonprinting characters: 

 

 
 

 

1. Choose the Home tab.  
2. Click the Show/Hide button in the Paragraph group . The Show/Hide button 

appears in a contrasting color, when it is selected. 

 

 

CREATE SAMPLE DATA AND SELECT TEXT  

If you type =rand() in your Word document and then press Enter, Word creates three 

paragraphs. You can use these paragraphs to practice what you learn. Throughout 

these lessons, you will be asked to select text. The following exercise teaches you 
how to create data and how to select data. You can select by using the arrow keys or 

by clicking and dragging. When using the arrow keys, use the up arrow to move up, 

the down arrow to move down, the left arrow to move left, and the right arrow to 
move right. When using the mouse, press the left mouse button and then drag in the 

direction you want to move. 

 
 

EXERCISE 1 

Create Sample Data 

1. Type =rand(). 

2. Press Enter. Three paragraphs appear in your document. 

 

Select with the Shift and Arrow Keys  

1. Place your cursor before the word "On" in the first paragraph. 

2. Press and hold down the Shift key, which serves as an "anchor" showing where 
text you wish to select begins or ends.  

3. Press the right arrow key until the first line of text is highlighted. 
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4. Press the down arrow key until the first paragraph is highlighted. 

5. Click anywhere outside the highlighted area to remove the highlighting. 
 

Select with the Mouse  

1. Place your cursor before the word "You" in the second paragraph. 
2. Press and hold down the left mouse button.  

3. Drag the mouse until you have highlighted the second paragraph.  

4. Click anywhere outside the highlighted area to remove the highlighting. 
 

Place the Cursor  

During the lessons, you will often be asked to place the cursor at a specific location 
(the insertion point) on the screen. You place the cursor by moving the cursor to the 

specified location and pressing the left mouse button or by using the arrow keys to 

move to the specified location. 
 

EXERCISE 2 

The Arrow Keys 

1. Use the down arrow key to move down your document. 

2. Use the right arrow key to move to the right. 

3. Use the up arrow key to move up. 
4. Use the left arrow key to move to the left. 

 

Cursor 
1. Move around you document by using you mouse and clicking in a variety of 

location. 

2. Click in a location and type. Note what happens. 
EXECUTE COMMANDS WITH KEYBOARD SHORTCUTS 

There are many methods you can use to accomplish tasks when using Word. 

Generally, you choose an option by clicking the option on the Ribbon. However, you 
can also use shortcut keys. A key name followed by a plus and a letter means to hold 

down the key while pressing the letter. For example, Ctrl+b means you should hold 

down the Ctrl key while pressing "b." A shorthand notation of the above would read 
as follows:  

Press Ctrl+b. Typists who are slowed down by using a mouse usually prefer using 

keys.  
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Start a New Paragraph  

When you type in Microsoft Word, you do not need to press a key to move to a new 
line. To start a new paragraph, press the Enter key.   

 

EXIT WORD  

Typically, you save your work before exiting. The exit button is located in the 

extreme right corner of your window.  

 

Close and Save 

1. Click the Microsoft Office button. A menu appears. 

2. Click Exit Word, which is in the bottom-right corner. 

3. You will be prompted: "Do you want to save changes to Document1?" To save 
your changes, click Yes. Otherwise, click No. If you click Yes, the Save As 

dialog box appears. 

4. Specify the correct folder in the Save In box. 
5. Name your file by typing Lesson One.doc in the File Name field.Click Save. 

Word saves your file as shown below. 

 

Retrieving Document 

Once the document has been 

saved, it exists in the computer. 
To open it, do the following: 

 

1. Click the office button 
2. Click open 

3. On the open window, 

choose where you saved the 
document 

4. Identify the document and 

click open 
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1.5 Editing and formatting a document 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
1.5.1 Editing a document 

 

Selecting text 

For you to be able to edit and format a document, the text should first be highlighted 

(selected). This can be done by using the following method 

 
1. One word- simply point the mouse and click or click and drag the mouse over 

it. You can also double click the word. 

2. A sentence- point the sentence and click if it is separated from the rest of the 
text, or click and drag the mouse over the sentence. 

3. A paragraph- triple click the paragraph i.e click three times. 

4. A whole document- place the cursor at the beginning of the document, hold 
the shift button down and click the end of the document. 
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Moving, copying and deleting text 

Moving text 

 

Moving a text means to relocate the text from its original place to another place. 
This is done by using cut and paste method. One you select text, simply click on cut 

option from the tool bar, or right click after selecting document on the pop-up menu 

as shown below. Position the cursor where you want to move the text and click 
paste. For example, you can cut and paste (move) one paragraph from one place to 

another.  

 
The above is the pop-up menu that appears when you right click. 

 

Copying text 

Copying text means making its duplicate elsewhere. This is done by selecting text, 

then clicking copy button from the tool bar or from the pop-up menu and pasting 

the text where you want it to be. 
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This is the pop-up menu that appears when you right click after highlighting text. 

 

Type, Backspace, and Delete 

In Microsoft Word, you create documents by typing them. For example, if you want 

to create a report, you open Microsoft Word and then begin typing. You do not have 
to do anything when your text reaches the end of a line and you want to move to a 

new line—Microsoft Word automatically moves your text to a new line.  If you want 

to start a new paragraph, press Enter. Microsoft word creates a blank line to indicate 
the start of a new paragraph. To capitalize, hold down the Shift key while typing the 

letter you want to capitalize.  If you make a mistake, you can delete what you typed 

and then type your correction. You can use the Backspace key to delete. Each time 
you press the Backspace key, Microsoft Word deletes the character that precedes the 

insertion point. The  insertion point is the point at which your mouse pointer is 

located. You can also delete text by using the Delete key. First, you select the text 
you want to delete; then you press the Delete key. 

 

EXERCISE 1 

Type and Backspace  

1. Type the following sentence:  

 
Alex has a very large house. 

 

2. Delete the word "house." Using either the arrow keys or the mouse, place the 
cursor between the period and the "e" in "house." 

3. Press the Backspace key until the word "house" is deleted. 

4. Type boat. The sentence should now read: 
"Alex has a very large boat." 

 

 
Delete  

Delete the word "very" from the sentence you just typed. 

1. Select the word "very." You can place the cursor before the "v" in the word 
"very," press and hold down the Shift key, and then press the right arrow key 

until the word "very" is highlighted. 

2. Press the Delete key. The sentence should now read:  
"Alex has a large boat." 
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Insert and Overtype 

While creating your document, you may find you need to insert text—place new text 
between existing text. Suppose, you type the sentence, "Alex has a large boat."  After 

typing it, you decide you want to change the sentence to "Alex has a large blue boat." 

With Microsoft Word, inserting a word, phrase, or even several paragraphs is easy. 
 

Alternatively, you may want to overtype text—replace old text with new text. For 

example, suppose you type the sentence, "Alex has a large blue boat." After typing 
it, you decide you want to change the sentence to  "Alex has a large gray boat." With 

Microsoft Word, overtyping the word blue with the word gray is also easy.  Before 

you attempt to insert or overtype, you should check the mode you are in—Insert or 
Overtype. You right-click the Status bar and then use the Customize Status Bar menu 

to place the Insert/Overtype button on the Status bar. You can then use the 

Insert/Overtype button to switch between Insert and Overtype mode. When you are 
in Insert mode, you can insert text. When you are in Overtype mode, you can 

overtype text. By default, Microsoft Word is in the Insert mode. 

 
EXERCISE 2 

Placing the Insert/Overtype button on the Status bar 

1. Right-click the Status bar. The Customize Status Bar menu appears. 
2. Click Overtype. The Insert/Overtype button appears on the Status bar. 

3. If the word Insert appears on the Status bar, you are in Insert mode. 

4. If the word Overtype appears on the Status bar, click the word Overtype and it 
will change to Insert, thereby changing Word to Insert mode.  

 

Insert 

Make sure you are in Insert mode before proceeding. You are going to insert the 

word "blue" between the words "large" and "boat."  

1. Place the cursor after the space between the words "large" and "boat." 
2. Type the word blue. 

3. Press the spacebar to add a space. 

4. The sentence should now read:  
"Alex has a large blue boat." 
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Overtype  

You can type over the current text (replace the current text with new text) in the 

Overtype mode. Do the following to change to the Overtype mode.  

• Click "Insert" on the Status bar. The word Insert changes to Overtype. 
Change the word "blue" to "gray." 

1. Place the cursor before the letter "b" in "blue." 

2. Type the word gray. 
3. The sentence should now read:  

"Alex has a large gray boat." 

Note: You can overtype text without changing to Overtype mode by selecting the 
text you want to overtype and then typing.  

 

1.5.2 Find and Replace 

In Microsoft Word 2007, When you click find   

 

 

 
The following window appears: 

 

 
 

 
Inside the Find what box, type a word or a sentence you intend to find to be replaced 

by another word or sentence. 
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Example: Type the name Alex inside Find what box 

 
Once you have typed the word, click the Replace tab, the following window appears: 

 

Inside the Replace box, type the word you intend to replace Alex with. Then click 
replace if it is one word, or Replace All. The word or words will then be 

simultaneously replaced. 

 
 
1.5.3 Proof Reading 

Microsoft word 2007, as mentioned earlier has the ability to identify spelling and 

grammar errors and correct them. It is always a good practice to proof read your 
documents before sending them for printing for an examination. Under this section 

we will look at spelling and grammar, the use of thesaurus, auto-correct and the use 

of undo and re-do buttons.  
 

 Spelling and grammar check 

The keyboard shortcut F7 takes you straight to spelling and grammar check window 
shown below. You can also click Review menu and then choose spelling and 

grammar. 
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Steps to use: 

Once the word with a spelling or a sentence with grammar problem is shown inside 

the Not in Dictionary box, look at the suggestions given in the suggestions box and 

click Change if it one word or change All if they are many word with the same 
spelling mistakes. You can decline to change it or them by clicking Ignore or Ignore 

All respectively. 

 
Please note that on the spelling and Grammar window, the English language being 

used is shown. For instance the current one is English (U.S). You can vary this by 

choosing the arrow on Dictionary language as shown above. 
 

Thesaurus 

This is the feature which will enable you to get alternative words which have the 
same meaning (synonyms) as a word you intend to change. It also provides words 

with opposite meanings (antonyms). 

 
Steps to use 

Select the word to search a different meaning for under thesaurus. 

Click on Review menu, then click Thesaurus as shown below. 
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Example: 

The word review above has been selected and the procedure above followed. The 

result from thesaurus looks as shown.  

 
 

 

 
 

 

 
 

Alternatively, select the word then right click on it, then; the following pop-up menu 

will appear. Choose synonyms, then thesaurus as shown below. 
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Auto-correct 

This feature is used to automatically replace either frequently misspelled words or 

long words that you do not intend to type completely because they consume time to 

type. These words must be included in the autocorrect dictionary if this feature is to 
be activated. 

 

Example 
Words such as miscellaneous are often long and tedious to write. You may also 

decide that everytime you write a misspelled word more as moer, it should 

automatically be corrected to more. This is how to set up the autocorrect feature. 
Steps 

Select the word to autocorrect e.g moer above 

Right click on it. The following menu appears 
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When you click the Autocorrect the following window appears:
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Note the word moer inside the replace box, the cursor is blinking inside thewith box. 

Simply type the word more inside the replace box. Once you type the word more, 
the Add button will be activated. Once you click on it, the both words will be added 

to the dictionary as shown below. 

 
 
 

 

 
 

 
 

 

 
 

 

 

Add is activated 
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The following window now shows that both words are added to the dictionary. 

 

 

 
 

This process is the same for long words like miscellaneous. Simply enter a short 
form under autocorrect e.g. misc. Once entered, it will always correct it to the full 

word immediately you press space bar from the keyboard.  

 
 

Undo and Redo 

 

 
Undo 
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The undo icon is used to clear what has recently been done and which you do not 

intend to have as part of the text. However, if you do realize later that you have 
cleared a word, a sentence and so on by mistake, you can use re-do to bring it back 

to be part of your text. 

 
 

1.5.4 Formatting a document 

1.5.4.1 Text Formatting 

The aim of formatting text is to make it more reader friendly by bolding, italicizing, 

changing fonts and font types, changing cases and so on. 

 
The first step as has been mentioned elsewhere in this topic is to select the text first. 

One the selection has been done, one has the option of using either the shortcut 

commands on the shortcut tool bar or clicking Font and accessing the commands 
from there. 

 

 
 

 

Here is the window: 
 

 
 

 

Redo 

Underline 
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The action is performed immediately you click the either B I or U after selecting the 
word or sentence and so on. 

 

If you click the arrow under Font, the window below will open. The menu found in 
this window contains the shortcut commands above. 

 

The bold(B), Italic (I) commands are found under Font style. The underline (U) is 
found under underline style. Under font, you find the different fonts i.e the different 

‘hand writing’ styles. There is also size box which contains the different sizes of the 

Fonts and the Font colour box, contains the different colours you could apply to the 
fonts chosen. 

Bold Italic Arrow to access 

the Font Menu 
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Change case 

Capital letters, small letters and so on are known as cases in WP. In this section we 
are looking at the different cases that are provided for. To access the different cases, 

click Aa on shortcut tool bar as shown below: 
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There are five different cases that you can change your sentence to. To apply the 

different cases, simply select your sentence and click the case you desire to change 
your text to. 

 

1. Sentence case- this is where the first letter in a sentence is capital and the 
rest are small. Example is: Sentence case. Note that the first letter is 

capital and the rest are small 

2. Lower case are small letters. Example: lowercase, Note that there is no 
capital letters. 

 

3. Uppercase are capital letters. Example is: UPPERCASE, note that they 
are all CAPITAL letters. 

 

4. Capitalize Each Word- when you apply this case, each word in the 
sentence is made to start with a capital letter. Example is Capitalize Each 

Word. 

 
5. tOGGLE cASE – this is where the first letter in a word  is small and the 

rest are capital. The example is as shown in the toggle case above. 

 

 

 

Drop caps 

 drop cap is the first letter in a sentence which is capital and spans two or more 

sentences downwards. 

 

A 

Drop Cap 
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To apply a drop cap, do the following: 

• Highlight the first letter you intend to put drop cap on. 

• Click insert menu, choose drop cap, by clicking on the arrow that appears under 

it.  

 
This is shown below: 

 

 
 

 

There are two types of drop caps as shown above: Dropped and In margin. The 
former is dropped by a some lines, whereas the latter stands on a separate margin 

from the main text. 

 
Hint: To remove the drop cap, simply select the drop cap and click none above to 

remove it. 

 
Superscript and Subscript 

Superscript is a character which appears superimposed above a text, whereas 

subscript appears beneath a text. Example: 
 

5510 5510  

 

Superscript 
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Applying Superscript and Subscript 

Select the letter or number to apply as superscript or subscript. 

On the shortcut tool bar, click 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

You can also access the X2 and X2 by clicking the arrow on the font menu above. 

 
Under effects, check (tick) the box for superscript or subscript as appropriate. 

 

1.5.5 Paragraph formatting  

 

Formatting alignment on paragraph includes alignment, indentation, spacing, 

applying section breaks, inserting bullets and numbering, page and section breaks 
among others. All these are found under paragraph menu in Microsoft Word 2007. 

 

 
Alignment 

Subscript 

Subscript 

Superscript 

Arrow to 

Font Menu 
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To align text means to position it to the left, centre, right or justified. 

 
Highlight the text to align, then click the following icons respectively. 

 

 
 

 
 

 

 
 

Hint: When you click the arrow on paragraph above, you obtain the same menu under 

alignment box. 
 

Exercise: Click the paragraph arrow and identify the alignments within the 

paragraph window. 
 

Align left Centre 
Align Right 

Justify 
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Indentation 

To indent means to move away from the margins. You can indent text to the left by 

placing your cursor at the beginning of text, then click decrease indent shown below, 

 

 
Or you could indent to the right by clicking on increase indent as shown below. 
 

 
Hint: On paragraph window above, under indentation, you perform the alignment by 

specifying under left or right box, in terms of centimeters(cm) or any other unit of 

measurement defaulted on your computer. 
 

Exercise 

Change the left alignment to 3cm and check the position of your cursor on screen. 
You can be guided by the ruler on your screen. 

 

Spacing 

This is the space between one sentence and another, vertically. 
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To apply spacing, select the text, click on line spacing below and choose the line 

spacing you wish to apply. 
 

 
Exercise: Identify the line spacing box under paragraph window. 

 
You can also add spacing before and after paragraph by clicking on Add space before 

paragraph or Add Space after Paragraph above.  

 

What this does is, from the word where you want to add space before, there will be 

a space on top of that word, and space after paragraph will create space after the word 
selected. 

 

 

Example  

Observe keenly the changes that this original text will have after applying Add space 

before and after paragraph commands. 
 

Explanation 

The text highlighted in green is selected and Add space before paragraph option 

used. Note the space on top of the word spacing that is highlighted with red colour. 

 

Sample task 

Change the left alignment to 3cm and check the position of your cursor on screen. 

You can be guided by the ruler on your screen. 

Spacing 
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This is the space between one sentence and another, vertically. 

 

 

 

a) Add space before paragraph 

 

Exercise 

Change the left alignment to 3cm and check the position of your cursor on screen. 
You can be guided by the ruler on your screen. 

      Spacing 

This is the space between one sentence and another, vertically. 

 

b) Add space after paragraph – this will create space after the word 

spacing as shown above. 
 

Exercise: By going to the paragraph menu, specify the space through up and down 

arrows shown below. 
 

 
 
Bullets and numbering 

Bullets and numbering are classified as list. They typically used to list items in some 

order. The bullets are basically symbols and the numbering can be alphabets, decimal 

Pace created before the word 
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numbers (1-10) or roman numerals ( i-x). Under this listing, you also find multi level 

list, basically used where you have a main point broken down into sub-points. 
 

Bullets 

Highlight the list to apply bullets to and then click bullets of your choice. The bullets 
will be applied to your list. 

 

 
 
To remove the bullets, simply highlight the text and click none above. 

 

Numbering 

Highlight the list to apply numbering to and then click numbering of your choice. 

The numbers will be applied to your list. 
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Exercise 

Explore the multilevel list by applying to a list. 
 

Page and Section breaks 

Page break divides a page by inserting a new one from the point of the cursor. Section 
breaks inserts a new section form the point of the cursor. There different types of 

page and section breaks as shown below. 
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To apply a break, simply place your cursor at the start point and click breaks above 

on page layout, then choose page or section break. 

 
1.5.6 Page formatting 

Page Setup menu incorporates page layout menu which has the commands necessary 

to format a page. These include margins, orientation, page size, columns, text 
direction, tabs and so on. This is shown below: 
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Page layout 

A page layout in Ms-word 2007 involves the margins,  orientation, paper size and 
columns. 

 

Setting the margins 
To set your own margins, click the arrow on margins. Once the setup window opens, 

insert left, right, top and bottom margins. 

 
Hint: to change measurement units from inches to cm, click office button and click 

word options. The following window will open. On measurement units, change to cm. 
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Changing orientation 

On page setup window above, change the orientation of your page by choosing either 
portrait (vertical orientation) or landscape (horizontal orientation). 

 

 

Paper size 

On page setup window above, change the paper size by first clicking the paper tab 

as shown below.  

Click to change to cm 
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The window below opens. Choose your paper size as desired, by clicking the arrow 

on A5 below. 
 

 
 

 
 

 

 

 Setting Columns 

To set columns, do the following: 

Click Page Layout menu 
Click columns 

Choose the desired columns from the list shown. 

Paper tab 

Choose paper size 
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Hint: You can also choose more columns if you want to put a specific gap between 

your columns. 

 
Exercise:  

 

Click on more columns and choose 3 columns, then apply 1.25cm gap between your 
columns. 

 

 
 

 

Headers and Footers 

Header is a running head or text that appears on top of every page. Footer on the 

other hand is text which appears below every page on your document. 

 
 

Setting headers and Footers 

Microsoft word 2007 has placed this command under Insert menu. 
 

• Click insert menu. Click header or footer. 

• Choose the appropriate layout and type the text to appear on them. 
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• Once you complete writing on your header, double click anywhere on the text 

to return to normal page. You can also click on  
 

 

 
 

Hint: If you double click on the header band once you have written your header, 

note the way the shortcut tool bar changes with new commands written header and 

footer Design 

 

Exercise: Use the window below to answer the questions given. 
 

1. Set your header and then click the Different first page box and write down your 

finding. 
2. Do the same for different Odd and Even Pages 

3. Try the use of Header from top and Footer from bottom by changing the 
numbers shown in the box. Write down your findings. 

 

 
Inserting Page numbers 

 

Click insert menu, choose page number and choose where you want your page 

numbers to appear. 
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Exercise 

1. Click on Format Page Numbers option and choose the number format of your 

choice. 

 
2. Remove the page numbers you have placed on your document. Write the steps 

you have followed to do this. 

 
1.5.8 Creating and Editing a Table 

Creating tables in Ms-word 2007 is easy. Simply place the cursor where you want 

the table to go.  
On insert menu, click table. By highlighting over the rows and columns, you are 

choosing the number of rows and columns you wish to have on your table. 

  
Observe the following and record you think the author is doing by clicking on the 

table menu and the insertion taking place. 

 

 
 

 

 

Row 

Colum

n 

Another option 

to create a table 
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Hint: the author have chosen a 4x4 table from the table menu above and the same 
has been placed below as a table. 

Exercise 

Create a table by clicking on insert table option shown above. Write the difference 

between the two methods. 

 
Editing tables 

Tables can be resized, new columns/rows inserted, rows/columns can be merged and 

they can also be split. 
 

Resizing rows/columns 

The easier way of expanding your rows is to place the cursor within a row and press 
enter. 

 

 

 
Hint: Alternatively, select the row to expand and right click. A pop-up window will 

appear, choose table properties then click the row tab. The window below will 

appear. On size, specify height. 
 

 

 

 

   

    

    

    

4x4 

table 

Enter 

pressed 

once 
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Resizing columns 

Place the cursor on the boundaries of the column you intend to expand. A double 
headed pointer as shown below will appear. Columns are resized by moving the 

double headed pointer in the direction you want to expand the table.  

 
 

This is illustrated below. 

 
 

 

 
 

 

 
 

 

 
Inserting rows and columns 

To insert a row or a column, simply select the row or column. Right click on it and 

click insert, then choose row/column and the position of insertion desired 

 
 

   

    

    

    

Stretch 

in the 

direction 

desired 
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Deleting rows/columns 

• Highlight the row/column to delete. 

• Right click on it 

• On the pop-up menu, click either delete rows or delete columns depending on 

what you selected to delete. 
 

 

Merging rows/columns 

• Highlight the row/column to merge 

• Right click on the same 

• On the pop-up window click merge cells. 

• The cells will be merged. 

 

Entering data in a table 

Simply place your cursor in the cell you wish to enter data and type the usual way.  
 

Exercise 

Type inside a cell and then change the text direction vertically. 
 

Hint: Simply highlight the cell containing text and right click. Choose text direction 

from pop-up window. 
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Formatting Tables 

Formatting a table is to make it appealing to the reader. You can put borders and 
shading on it to enhance the contents. 

 

Steps: 

Highlight the entire table or row/column as desired. 

Right click and choose borders and shading from the pop-up menu. 

 
When you click on borders and shading, the following window pops-up. 

 
When the borders tab is clicked, the following is seen. 
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To apply the borders  

• Highlight where to apply border, 

• Click a setting e.g. Box, grid 

• Choose the style you want, 

• Choose colour 

• Choose width to apply to the borders 

• On Apply to box, click where to apply the border  

 
Exercise 

Create a table of 4 rows and 5 columns 

Apply the grid borders to the table 
Apply colour of your desire 

Apply appropriate width. 

 
Exercise  

Using shading tab, apply shading on the first row of the table in on the exercise above. 

Make sure to choose, the style, the colour and where to apply the shading. 
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Split cells 

Click in a cell, or select multiple cells that you want to split.  

Under Table Tools, on the Layout tab, in the Merge group, click Split Cells. 

Hint: Once you highlight, the table tools will appear on top of the menus. 

 

 
 

 

 

 

Table conversions 

Ms-Word 2007 allows you to convert contents of a table into text and likewise 
convert text into a table. 

 

This feature is used to convert the selected text into a table, splitting the text into 
columns at each comma 

period, or other characters you specify. 

 
For example the sentence above beginning with the word this feature... is separated 

by three commas, hence making them four sentences. To convert the sentence into 

columns, select the text, then click insert menu and choose table. On the drop down 
box, choose convert text to table. The following will be the result: 
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The result is this: 

 

This 
feature is 

used to 

convert 
the 

selected 

text into a 
table 

splitting 
the text 

into 

columns at 
each 

comma 

period or other 
characters 

you 

specify. 

 

 

 

Converting table to text 

 

Highlight the table to convert to text. On table tools, click convert to txt as shown 

below. 

 

Click 

this 



amosobiero7@gmail.com 

 

 

Page | 55  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

 
 

Sort the contents of a table 

In Print Layout view, move the pointer over the table until the table move handle 

appears.  

Click the table move handle to select the table that you want to sort.  
 

 

 
 

 

 
 

 

 
 

 

Under Table Tools, on the Layout tab, in the Data group, click Sort.  
In the Sort dialog box, select the options that you want. 

 

Sort 



amosobiero7@gmail.com 

 

 

Page | 56  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

 
 

 

 

Sort a single column in a table 

Select the column that you want to sort.  

Under Table Tools, on the Layout tab, in the Data group, click Sort.  
Under My list has, click Header row or No header row.  

Click Options.  

Under Sort options, select the Sort column only check box.  
Click OK. 

 
Sort by more than one word or field inside a table column 

To sort the data in a table that is based on the contents of a column that includes more 

than one word, you must first use characters to separate the data — including data in 
the header row. For example, if the cells in a column contain both last and first names, 

you can use commas to separate the names. 

Select the column that you want to sort.  
Under Table Tools, on the Layout tab, in the Data group, click Sort.  

Under My list has, click Header row or No header row.  

Click Options.  
Under Separate fields at, click the type of character that separates the words or fields 

that you want to sort, and then click OK.  

Under Sort by, in the Using list, select which word or field you want to sort by.  
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In the first Then by list, enter the column that contains the data that you want to sort 

by, and then in the Using list, select which word or field you want to sort by.  
If you want to sort by an additional column, repeat this step in the second Then by 

list. 

Click OK. 
 

Arithmetic Calculations 

Once you have a set of data in a table as shown below, Ms-word provides you with 
an option to enter a formula and perform calculation on the data present. 

To insert a formula in the cell under profit, simply place your cursor where the 

answer should be, and go to Table tools menu. On layout, click formula (fx) as shown 
below. The formula appears for you [=sum(above)] and the word above indicates the 

items to be added. If the formula is not the one you intended to have, simply go paste 

function, and choose the right function. Click ok to perform calculation. 
 

 

Item Purchase 
Price  

Sales Price  Profit 

Beans 145 278 133.00 

Potatoes 200 520  

Flour 300 430  

Total 645   

    

On Number format, choose the format you want e.g. 0.00 to mean two decimal places 

for the answer. 
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Updating your answer 

Hint: if you change any number within the cells, the answer will not be updated 

automatically. Simply go to the cell containing the answer, right click and choose 

update. The answer will then be updated for you. 
 

Exercise 

From the table above, show how the author obtained the answer 133 for the profit 
under the item beans. 

 

 
1.6 Creating and Updating a Mail Merge document 

 

Mail merge is a key feature of Ms-word. It is a process which allows the user to 
create a main letter (envelope, email or labels) and merge it with data source (list of 

addresses) to produce personalized letters. This is normally applicable in situations 

where you need to produce many letters for different people, yet having some aspects 
of that letter being standard. 

 

Example 

You can use mail merge to produce letters for students in a school who obviously 

have different addresses and different school fees balances. 

 
Steps of mail merge 

Mail merge is a three step process which involves the following: 

 
1. Creating a main letter or envelope or labels 

2. Creating or importing a data source (also known as recipient’s list) 

3. Merging the main document with the data source. 
 

 

 
 

1. Creating Main document 
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The main document being a letter usually has certain features which are common for 

everyone and others which are unique to the individual. Such a letter will often take 
the following format: 

 

 
EFFORTS ACADEMY 

P.O. BOX 1550-00200, NAIROBI, KENYA 

 

<Prefix><Firstname><Lastname> 

P.O. Box <address> 

Email <email address> 

<town> 

 

Dear< Prefix><Lastname>, 

 

RE: SCHOOL FEES BALANCE 

 

This is to remind you that your < child> according to our records owes the school 
<kshs>.  

 

We would request that you clear this fee balance in <days> days, failure of which 
we may be forced to send the child home. 

 

Thank you 
 

Accountant 

 
The above is a sample letter. The fields marked by <>, means they are all unique and 

will be filled by details from the data source or recipients list.  

 
To create the above letter, open a new Ms-word document and start typing it as it is. 

 

Once you have typed the letter, do the following: 
Click Mailings, 
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Click step by step Mail Merge Wizard 

 

On your right hand side, mail merge options appear as shown below. 
 

 

 
 

 
Choose the option you want, but in this case click the radio 

button for letter. 

Then click next on step 1 of 6 
 

 
 

Choose use the current document from the window that 

appears. 
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Click Next: Select recipients below. 
 

 

 
 

 

 
 

 

 
Once the option of select recipients is opened, you have the option to choose the 

options as shown below. 

 
 

 

Choose the third option, type a new list. You choose the 
first option if you have a list already existing and saved in 

the computer or elsewhere. You could also have your list 

from outlook contacts. 
 

When you click on the option above, an icon for create 

appears immediately below it as shown below. 
 

 

When you click create, the following window appears. This 
will allow you to create the data source. 
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You have the option to start typing within the field names shown in the New 

Address List or if they do not fit your common fields left in the letter above, then 
click customize columns 
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In the customize Address List that appears, ensure that the fieldnames are renamed 

according to the letter above. You can rename the existing ones by clicking rename, 

or Add, if you simply want a fresh list as per your letter and then use the option 
delete to delete all the other fieldnames that do not fit your requirements. Once 

completed click ok. The complete list is shown below. 

I have chosen to rename the fieldnames and afterwards delete what I do not need. 
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This is done repeatedly until all the fields are changed. The final results look like 

this.  
 

 

 
 

Enter data once the window appears. Some two records have been entered already. 

Once you complete the process of entering data, then click Ok. The Save As 
window will appear. Save the data source. 

 

Observe the left side of the window and see the edit recipient list is activated as 
shown below. 

 
 

 Activated 
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When you click on edit recipient list, the following window will be displayed 

showing your data source. 

 

 
The next step is inserting merge fields to the letter. 

On the tool bar, you will notice that the insert merge field is now activated ready 
for use. 
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Please note that the fieldnames we created are existing when you click the insert 

merge field as shown above. 
 

The next step is click and insert each of these fieldnames in their respective areas 

within the letter, the idea is to highlight<prefix>in the letter, and choose prefix 
from the insert merge field to substitute. The former fieldnames were just holding 

those places temporarily. 

 
This is how the letter will look like with the new fieldnames. 

 

 
EFFORTS ACADEMY 

P.O. BOX 1550-00200, NAIROBI, KENYA 

 

«Prefix» «FirstName» «LastName», 

P.O. Box «Address», 

Email: «Email_Address» 

«Town» 

 

Dear «Prefix» «LastName» 

 

RE: SCHOOL FEES BALANCE 

 

This is to remind you that your «Child» according to our records owes the school 
«Kshs». 

 

We would request that you clear this fee balance in «days» days, failure of which 
we may be forced to send the child home. 

 

Thank you 
 

Accountant 

 
Hint: Make sure you format the letter properly by creating enough spaces between 

fieldnames. 
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Exercise 
Can you spot the difference between this letter and the one before? 

 

Final step 

The final step is merging. Simply click finish & merge 

 

 
 

1.  Choose Edit individual Documents option. The following window will 

appear. Choose your option. 

 
 

 

For the purpose of this exercise, I will choose All radio button. 
The results will a merged document of two letters as per the data source. 

 

 

EFFORTS ACADEMY 

P.O. BOX 1550-00200, NAIROBI, KENYA 
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Mr. Kennedy Ochieng, 

P.O. Box 2234, 

Email:  

Siaya 

 

Dear Mr. Ochieng 

 

RE: SCHOOL FEES BALANCE 

 

This is to remind you that your son according to our records owes the school 3,500. 
 

We would request that you clear this fee balance in 21 days, failure of which we 

may be forced to send the child home. 
 

Thank you 

 

Accountant 

 

----------------------------------------------------------------------------------------------------

---------------- 

 

 
 

 

 
 

 

EFFORTS ACADEMY 

P.O. BOX 1550-00200, NAIROBI, KENYA 

 

Prof. Yusuf Hassan, 

P.O. Box 6789, 

Email:  

Mombasa 
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Dear Prof. Hassan 

 

RE: SCHOOL FEES BALANCE 

 

This is to remind you that your daugther according to our records owes the school 
4,500. 

 

We would request that you clear this fee balance in days, failure of which we may 
be forced to send the child home. 

 

Thank you 
 

Accountant 

 
 

 

Note: Since we did not merge the field for <days>, nothing has come in that field. 
 

 

 
 

 

 
 

Apart from choosing the edit individual documents, you can also decide to: 
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2. Choose print documents option which enables you to print the documents 

and post as hard copies or  
3. you can choose send email messages, in which case, the merged documents 

will be sent as email messages. When this happens, the individual person to 
whom the letter was written receives only an email copy of that document. 

 

Exercise 

Click the option of send as email messages and write down the steps used till the 

documents are sent. 

 
 

 

 
1.8 Printing Documents 

Printing provides you with hard copy of what you see on the screen. The printed 

documents form an age old way to keep documents for future reference. 
1.8.1 Printer setup 

To setup a printer using windows Xp do the following: 

• Click start 

• Click Printers and faxes or go to control panel and click printers and faxes 

 

• Click Add a printer on the printers and faxes window 

• On Add a printer wizard, click next and follow the instructions to finish 

Option 2 

Option 3 
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NB: All printers currently require 
that you install the printer drivers 

(software) first, before you set it 

up. Often the instructions given 
above are used when the printer 

drivers are presently in your 

computer. 
 

Once your printer is installed, you 

can preview your documents 
before printing to ensure the 

document output is as required. 

 
Print preview 

Click office button 

Click print, then, print preview 
 

 
 

When you click print preview, you will decide on whether to go ahead and print or 

make modifications appropriately. Such changes are explained below. 
 

 

Print Options 
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Once on preview window, the shortcut tool bar changes as shown below: 

 
 

The print options available for 

you include changing margins, 
paper orientation, size and so on. 

 

Printer selection 

When you click on print, there are choices that you can make before you print the 

document. 

 
On print window, under printer, the defaulted printer is the one that pops under name. 

If it is not the one you intend to use, click on the arrow and choose another printer. 

 
 

On page range, you can choose to print All pages, current page which means where 
the cursor is currently placed or you can take the third option, pages, where you 

specify the range of pages to print such as 1, 3, 5-13. This means, it will print page 

1, skip page 2, print page 3, skip page 4, and print pages from 5 to 13.  
 

 

 
 

 

 
 

 

 
 

 

 
 



amosobiero7@gmail.com 

 

 

Page | 73  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

 

The last option on print is to choose the number of copies you want to print of each 
page. 

Under number of copies, type the number of copies you want for each page. 

 
 

 

 
 

 

 
 

 

 
 

Finally click ok to print the document. 

 
1.9 Inserting Graphics 

In Ms-word, there are 3 types of graphics provided. These are drawing, pictures and 

charts. You can insert any of these graphics by either drawing or importing them 
from file, internet or Clip Art. 

On insert menu, under illustrations, you can insert picture, Clip Art, shapes, 

SmartArt and Chart 
 

 

 
 

 

 
 

 

 
 

 

 
General instructions on insertion 

Type or choose by 

the arrows the copies 

to print. 
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1. Place the cursor where you want to place your graphic. 

 
2. Click on the illustration of your choice, and choose the specific graphic under the 

illustration. 

 
 

Drawing Shapes 

 
In case of the shapes, choose the shape and stretch the shape in the direction you 

want. For example, to draw a shape, click insert, then shapes, choose your shape 

from the drop down menu and follow these instructions. 

 
 

To draw the rectangle, click on it and place the cursor (now a plus sign) to the place 
you wish to draw the rectangle). Stick on the left mouse button and stretch the place 

sign to form the rectangular shape as shown below 

 
To resize a shape, use the dots or rectangles around the shape. When stretching it in 

a particular direction, make sure that you have double pointed arrows (      ) Then 

stretch in that direction to expand. To move the whole table, ensure you have a four 
headed arrow, stick the mouse and move in the direction desired. 

 Using text box 

Text Box 
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If you want to write inside a shape, click text box shown above. It provides with the 

space and the cursor to use for typing. 
Exercise 

Use shapes to draw an organisation structure of your school. Type the names 

of under each shape. 
 

 

 
 

 

 
 

 

 
 

 

CHAPTER 2 

 

SPREADSHEETS 

 
This chapter introduces the student to what Spreadsheets are, the components, 

application areas and the practical usage. 

 
 

 

 
 

 

 
 

 

 
 

 

 

 

2.0 Definition of Spreadsheets 

2.1 Components of a spreadsheet 

2.2Application areas of spreadsheets 
2.3 create and edit a Spreadsheet 

2.4 explain different cell data types 

2.5 Apply cell referencing 
2.6Apply functions and formulae 

2.7 Apply data management skills 

2.8 Apply charting and graphing skills 

2.9 Print worksheet and graph 



amosobiero7@gmail.com 

 

 

Page | 76  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

2.1 Definition of Spreadsheets 

A spreadsheet is a grid that organizes data into columns and rows. Spreadsheets 
make it easy to display information, and people can insert formulas to work with 

the data. The columns are marked by letters and the rows are marked by numbers. 

For example column A, B, C beyond letter 26 i.e Z, the columns are marked as AA, 
AB etcetera. The intersection of a row and a column is often known as a cell. Each 

cell has a name known a cell reference. Each cell is named by the column and the 

row in which the cell falls under. For example, Cell A3 means that it is on column 
A and row 3. The cell where the cursor is placed operations is known as an Active 

cell. 

 

 
 

 
 

 

 
 

2.1 Components of a Spreadsheet 

A spreadsheet is made up of three key components. These are: worksheet, database 
and graphs. 

2.1.1 Worksheet 

A spreadsheet is made up of many worksheets as shown above in the sheet tab. The 
total sum of all the worksheets, make up a workbook. The figure above is a 

Formula Bar Cell Reference 

bar       Active cell 

Column 

Sheet tab 

Row 

Row 
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workbook. Each of these worksheets may hold different sets of information. You 

can add as many worksheets as you wish in a workbook. 
2.1.2 Database 

A spreadsheet can hold many records properly ordered in a given format. These 

records are about particular people or things which make up the records, classified 
under specified fields. This is a database. Such records are related and could be 

placed together in one worksheet to mean a file of an entity. 

 
2.1.3 Graphs 

A spreadsheet provides a pictorial representation of data in the form of a graph. 

This is a key feature of a spreadsheet. Whereas words describe analysed data, 
graphs provide a quick way to visualize the same output. 

 

2.2. Application areas of a spreadsheet 

Spreadsheets are often used in the following application areas: 

a) Statistical data analysis 

b) Accounting 

c) Data management 

d) Forecasting(what if analysis) 

e) Scientific application 

 

2.2.1 Statistical Analysis 

2.2.2 Accounting 

2.2.3 Data management 

2.2.4 Forecasting (what if analysis) 

2.2.5 Scientific application 

 

2.3 Creating a worksheet/workbook 

2.3.1 Getting started 

For purposes of this syllabus we shall use Microsoft Office Excel (MS-Excel). 

➢ Go to start button 

➢ Click Microsoft Office Excel 
➢ The worksheet below will open 

 

2.3.2 Worksheet layout 

The following worksheet loads when you click on MS-Excel. 



amosobiero7@gmail.com 

 

 

Page | 78  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

The parts of this worksheet has been explained above, section 2.0. The menus will 

be explained as we move along. The office button, operations button such as exit, 
minimize, maximize and restore remain the same as in Ms-Word. 

 

 
 

 

 

 

2.3.3 Running the program 
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Practical Learning: Starting Microsoft 
Excel 

To start Microsoft Excel, from the Taskbar, click 

Start -> (All) Programs -> Microsoft Office -> Microsoft Office Excel 

   

Introduction 

When Microsoft Excel opens, it displays an interface divided  

in various sections.  

The top section displays a long bar also called the title bar.  

The title bar starts on the left side with the Office Button .  

If you position the mouse on it, a tool tip would appear:  

 

The Options of the Office Button 

When clicked (with the mouse's left button), the Office Button  

displays a menu:  

javascript:HHCTRL.TextPopup(Action,popfont,9,9,-1,-1)
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As you can see, the menu of the Office Button allows you to  

perform the routine Windows operations of a regular application,  

including creating a new document, opening an existing file, or  

saving a document, etc. We will see these operations in future  

lessons.  

If you right-click the office button, you would get a short menu:  
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We will come back to the options on this menu. 

The Quick Access Toolbar 
   

Introduction  

On the right side of the Office Button, there is the Quick Access  

Toolbar .  

Like a normal toolbar, the Quick Access displays some buttons.  

You can right-click the Quick Access toolbar. A menu would  

appear:  

 

If you want to hide the Quick Access toolbar, you can  

right-click it and click  

Remove Quick Access Toolbar. To know what a button is  

used for, you can position the mouse on. A tool tip would  

appear. Once you identify the button you want,  
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you can click it.  

Adding a Button to the Quick Access 
Toolbar 

By default, the Quick Access toolbar is equipped with three  

buttons: Save, 

 Undo, and Redo. If you want to add more buttons or more  

options, you can right-click the Quick Access toolbar and  

click Customize Quick  

Access Toolbar... This would display the Excel Options dialog 

 box:  

 

To add a button to the Quick Access toolbar, on the left list of  

Add, click an option and click Add. After making the selections,  

click OK.  

To remove a button from the Quick Access toolbar, right-click  
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it on the Quick Access toolbar and click Remove From Quick 

 Access Toolbar.  

The Quick Access Button 

On the right side of the Quick Access toolbar, there is the  

Customize button with a down-pointing arrow. If you click or  

right-click this button, a menu would appear:  

 

The role of this button is to manage some aspects of the top  

section of Microsoft Excel, such as deciding what buttons  

to display on the Quick Access toolbar. For example,  

instead of using the Customize Quick Access 

Toolbar menu item as we saw previously, you can click an  
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option from that menu and its corresponding button would  

be added to the Quick Access toolbar. If the options on the menu are nor enough, you can  

click either Customize Quick Access Toolbar or More 

 Commands...  

This would open the Excel Options dialog box.  

The main or middle area of the top section displays the name  

of the application: Microsoft Excel. You can right-click the  

title bar to display a menu that is managed by the operating  

system.  

On the right side of the title bar, there are three system buttons  

that allow you to minimize, maximize, restore, or close  

Microsoft Access.  

Under the title bar, there is another bar with a Help button on 

 the right side.  

The Ribbon 

   

Introduction 

Under the title bar, Microsoft Excel displays a long bar called the Ribbon:  

 

Minimizing the Ribbon 
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By default, the Ribbon displays completely in the top section  

of Microsoft Excel under the title bar. One option is to show  

it the way the main menu appeared in previous versions of  

Microsoft Excel. To do this: 

• Right-click the Office Button, the Quick Access toolbar,  

or the Ribbon itself, and click Minimize the Ribbon 

• Click or right-click the button on the right side of the  

Quick Access toolbar: 

 

This would display the Ribbon like a main menu: 
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To show the whole Ribbon again: 

• Right-click the Office Button, the Quick Access toolbar,  

or one 

 of the Ribbon menu items, and click Minimize the  

Ribbon to remove the check mark on it 

• Click or right-click the button on the right side of the  

Quick Access toolbar and click Minimize the Ribbon to  

remove the check mark on it 

• Double-click one of the menu items of the Ribbon 

Changing the Location of the Ribbon 

By default, the Quick Access toolbar displays on the title bar  

and the Ribbon displays under it. If you want, you can switch  

their locations.  

To do that, right-click the Office Button, the Quick Access  

toolbar, or the Ribbon, and click Show Quick Access Toolbar  

Below the Ribbon: 
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To put them back to the default locations, right-click the Office  

Button, the Quick Access toolbar, or the Ribbon, and click  

Show Quick Access  

Toolbar Above the Ribbon. 

The Tabs of the Ribbon 

The ribbon is a type of property sheet made of various property  

pages.  

Each page is represented with a tab. To access a tab: 

• You can click its label or button, such as Home or Create 

• You can press Alt or F10. This would display the access key of each tab: 

  

 

 

 

• To access a tab, you can press its corresponding letter  

on The keyboard. For example, when the access keys  
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display, if you press Home, the Home tab would display 

• If your mouse has a wheel, you can position the mouse  

anywhere on the ribbon, and role the wheel. If you role  

the wheel down, the next tab on the right side would  

be selected. If you role the wheel up, the previous tab  

on the left would be selected. You can keep rolling  

the wheel until the desired tab is selected 

To identify each tab of the Ribbon, we will refer to them by  

their names. 

The Sections of a Tab 

Each tab of the ribbon is divided in various sections, each  

delimited by visible borders of vertical lines on the left and  

right.Each section displays  

a title in its bottom side. In our lessons, we will refer to  

each section by  

that title. For example, if the title displays Font, we will call 

 that section, 

 "The Font Section". 

Some sections of the Ribbon display a button . If you see such 

 a button, 
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 you can click it. This would open a dialog box or a window. 

The Buttons of the Ribbon 

Since there are various buttons and sometimes they are 

 unpredictable, 

 to know what a particular button is used for, you can  

position your mouse on it. A small box would appear to let  

you know what that particular button is used for; that  

small box is called a tool tip: 

 

 

You can also use context sensitive help in some cases to  

get information about an item. 

You can add a button from a section of the Ribbon to the  

Quick Access toolbar. To do that, right-click the button on  

the Ribbon and click Add to Quick Access Toolbar: 
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Remember that, to remove a button from the Quick Access  

toolbar, right-click it on the Quick Access toolbar and click  

Remove From Quick  

Access Toolbar. 

The More Buttons of the Ribbon 

In some sections of the Ribbon, on the lower-right section,  

there is a button: 
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That button is used to display an intermediary dialog box for  

some action. 

 We will see various examples as we move on. 

When Microsoft Excel is occupying a big area or the whole  

area of the monitor, most buttons of the Ribbon appear  

with text. Sometimes you may need to use only part of the screen.  

That is, you may need to narrow the  

Microsoft Excel interface. If you do, some of the buttons may  

display part of their appearance and some would display only 

 an icon. Consider the difference in the following three  

screenshots: 

 

 

The Size of the Ribbon 
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In this case, when you need to access an object, you can  

still click it or click its arrow. If the item is supposed to have  

many objects, a new window may appear and display those  

objects: 

From this: 

 

To this: 

 

The Work Area 
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The Name Box 

Under the Ribbon, there is a white box displaying a name like  

A1(it may not display A1...), that small box is called the Name  

Box: 

 

The Insert Function Button 

On the right side of the Name box, there is a gray box with  

an fx button. That fx button is called the Insert Function button. 

The Formula Bar 

On the right side of the Insert Function button is a long empty 

 white box or section called the Formula Bar: 

 

You can hide or show the Formula Bar anytime. To do this,  

on the Ribbon, 

 click View. In the Show/Hide section: 
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• To hide the Formula Bar, remove the check mark on the  

Formula Bar check box 

• To show the Formula Bar, check the Formula Bar check  

box 

The Column Headers 

Under the Name Box and the Formula bar, you see the column  

headers. The columns are labeled A, B, C, etc: 

 

There are 255 of columns. 

The Row Headers 

On the left side of the main window, there are small boxes  

called row 

 headers. Each row header is labeled with a number, starting  

at 1 on top, then 2, and so on: 
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The Cells 

The main area of Microsoft Excel is made of cells. A cell is the 

 intersection of a column and a row: 

 

A cell is identified by its name and every cell has a name.  

By default,Microsoft Excel appends the name of a row to the  
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name of a column to identify a cell. Therefore, the top-left  

cell is named A1. You can checkthe name of the cell in  

the Name Box. 

Practical Learning: Using Cells 

1. Click anywhere in the work area and type A 

(It doesn't matter where you click and type) 

2. Click another part of the worksheet and type 42XL 

3. Click again another place on the worksheet type  

 

Fundamentals  

and press Enter 

The Scroll Bars 

On the right side of the cells area, there is a vertical scroll bar  

that allows you to scroll up and down in case your document  

cannot display everything at a time: 
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In the lower right section of the main window, there is a  

horizontal scroll bar that allows you to scroll left and right  

if your worksheet  

has more items than can be displayed all at once: 

 

Sometimes the horizontal scroll bar will appear too long or  

too narrow  

for you. If you want, you can narrow or enlarge it. To do this,  

click and drag the button on the left side of the horizontal  

scroll bar: 
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The Sheet Tabs 

On the left side of the horizontal scrollbar, there are the  

worksheet tabs: 

 

By default, Microsoft Excel provides three worksheets to start  

with. You can work with any of them and switch to another  

at any time by clicking its tab. 

The Navigation Buttons 

On the left side of the worksheet tabs, there are four navigation  

buttons: 

 

If you happen to use a lot of worksheets or the worksheet names  

Are using too much space, which would result in some  

worksheets being  

hidden under the horizontal scroll bar, you can use the  
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navigation buttons  to move from one worksheet to another. 

The Status Bar 

Under the navigation buttons and the worksheet tabs, the  

Status Bar provides a lot of information about the job that  

is going on. 

Microsoft Excel File Operations 

   

Saving a File 

A Microsoft Excel file gets saved like any traditional Windows  

file.  

To save a file: 

• You can press Ctrl + S 

• On the Quick Access Toolbar, you can click the Save  

button  

• You can click the Office Button and click Save  

Two issues are important. Whenever you decide to save a  

file for the first time, you need to provide a file name and  

a location. The file name helps the computer identify that  

particular file and register it. 

A file name can consist of up to 255 characters, you can  

Include spaces and dashes in a name. Although there are  
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many characters you can use in a name (such as  

exclamation points, etc), try to avoid fancy names.  

Give your file a name that is easily recognizable, a little  

explicit. For example such names as Time Sheets,  

Employee's Time  

Sheets, GlobalEX First Invoice are explicit enough. Like any  

file of the Microsoft Windows operating systems, a Microsoft  

Excel file has an extension, which is .xls but you don't have  

to type it in the name. 

The second important piece of information you should pay  

attention to when saving your file is the location. The location  

is the drive and/or the folder where the file will be saved.  

By default, Microsoft Excel saves its files in the My  

Documents folder. You can change that in the Save As  

dialog box. Just click the arrow of the Save In combo box  

and select the  

folder you want. 

Microsoft Excel allows you to save its files in a type of your  

choice.  

To save a file in another format: 
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• Press F12 or Shift + F12 

• You can click the Office Button and position the mouse  

on Save As and select the desired option: 

  

 

• On the Quick Access Toolbar, you can click the Save button .  

Then, in the Save As dialog box, click the arrow of the Save As  

Type combo box and select a format of your choice 

There are other things you can do in the Save As dialog box: 
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Practical Learning: Saving a File 

1. To save the current document, on the Quick Access  

Toolbar,  

2. click the Save button  
3. Type Fundamentals 

4. Click the Save button 

 

Saving under a Different Name and New Folder 

You can save a file under a different name or in another 

 location,  

this gives you the ability to work on a copy of the file while  

the original is intact. 

There are two primary techniques you can use to get a file in two  

names or the same file in two locations. When the file is not  

being used by any application, in Windows Explorer  
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(or in My Computer, or in My Network Places, locate the file,  

right-click it and choose Copy.  

To save the file in a different name, right-click 

 in the same folder and choose Paste. The new file will be named 

 Copy Of... You can keep that name or rename the new file with  

a different name (recommended).  

To save the file in a different location, right-click in the  

appropriate folder and click Paste; in this case, the file will  

keep its name. 

In Microsoft Excel, you can use the Save As dialog box to  

save a file in  

a different name or save the file with the same name  

(or a different name) in another folder. The Save As dialog  

box also allows you to create a new folder while you are  

saving your file (you can even use this technique to create  

a folder from the application even if you are not  

saving it; all you have to do is create the folder, click  

OK to register the folder, and click Cancel on the Save As  

dialog box). 

Practical Learning: Save a File With Different 

Settings 
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1. To save this file using a different name, click the Office  

Button, position the mouse on Save As, and click  

Excel 97-2003 Workbook 

2. Change the name of the file to  

Employment Application 

3. On the toolbar of the Save As dialog box, click the  

4. Create New 

 Folder button (if you have a hard time finding it,  

press Alt + 5 

5. Type My Workbooks and press Enter. The My Files  

folder should now display in the Save In combo box.  

If you clicked Cancel or pressed Esc now to dismiss the  

Save As dialog box, the computer  

would still keep the folder 

6. After making sure that the My Files folder displays in  

the Save In  

combo box, click the Save button  

Opening a File 

The files you use could be created by you or someone else.  

They could be residing on your computer, on another  
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medium, or on a network. Once one of them is accessible, you can 

 open it in your application. 

You can open a document either by double-clicking its icon in  

Windows Explorer, in My Computer, from the Find Files Or 

 Folders  

window, in My Network Places, or by locating it in the Open  

dialog box.  

To access the open dialog box, on the main menu,  

click File -> Open...  

You can also click the Open button on the Standard toolbar. 

A shortcut to call the Open dialog box is Ctrl + O. 

2.4 Cell Data Types 

The data that you enter in a cell can take any of the  

following for types: 

Labels- these are data which are in text form. For example  

titles on top of the columns or at the start of each row. 

Values- these are the result from a calculation. They are  

often in the form of numbers, currencies, dates and so on.  

Formulae- these are data that uses operators such as  

+,-,/,*, Brackets. 
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Functions- these are the cell data types which contains the  

Formulae which the spreadsheet has memorized and is 

 available in the library. A function usually contains an  

equal sign(=),function name such as sum, average, maximum 

 and so on, values to be used with the function. Example  

of a function in a cell would be: =sum(A2:A4). 

2.4 Cell referencing  

2.4.1 Cell Addressing 

A cell must have a cell address. The name of the cell. The  

Cells are addressed using column letter and row number.  

For example cell A3, means a cell positioned on column A  

and row 3. Microsoft Excel, just like any other spreadsheets, 

work with cell references instead of values. This is because    

the references provide an easy way to amend contents of a  

cell instead of the values. 

Example of use of a cell reference: 

The first uses cell references to add the two numbers. When  

this happens, you can easily change the contents of any of  

the two cells, and immediately the answer will change to  

correspond with the change you have made. In the second  
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formula, even if you change the content of the formula,  

the answer will not change at all. 

 

 

 

2.4.2 Absolute Referencing 

A cell whose contents need to remain constant  

Throughout the calculation period is referred to as  

Absolute reference. It is usually denoted by a dollar sign 

 thus, $B$2, this can be done simply by highlighting 

 the cell reference and then pressing F4 on the Keyboard  

to add the dollar signs.  

 

= (78+45) 



amosobiero7@gmail.com 

 

 

Page | 108  
FOR: Form 2, 3 & 4 NOTES, latest & Updated Schemes of Work, Quality Revision Booklets, Entry, 

Mid-Term& End-Term Exams, All KASNEB notes, Set-Books Acted Videos…….  
WhatsApp Sir Obiero Amos @ 0706 851 439 

 

 

 

 

  

 
 

 

 

 


